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Software License Agreement

Carefully read the following terms and conditions.

This is a legal agreement between you, the end user (either an individual or an
entity), and Scanvec Amiable, Inc. If you do not agree with the following, you
should promptly return the package. Use of this program indicates your acceptance
of the terms and conditions stated below.

The enclosed computer program "Software" is licensed, not sold, to you by
Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only
under the following terms, and Scanvec Amiable, Inc., reserves any rights not
expressly granted to you. You may not disclose to any third party any confidential
information concerning the Software or Scanvec Amiable, Inc. or use such
confidential information to the detriment of Scanvec Amiable, Inc...

1. License.

This software is protected by the United States Copyright Law and International
Treaty Provisions. Therefore, you must treat the Software just as you would any
other copyrighted material, such as a book. This license allows you to:

(a) Make one copy of the Software in machine readable form; provided that
such a copy of the original may be used solely for backup purposes. As an
express condition of this License, you must reproduce on each copy of the
Scanvec Amiable, Inc., copyright notice and any other proprietary legends on
the original copy supplied by Scanvec Amiable, Inc.

(b) Transfer the Software and all rights under this License to another party
together with a copy of this License and all written materials accompanying
the Software provided you give Scanvec Amiable, Inc., written notice of the
transfer and the other party reads and agrees to accept the terms and
conditions of this License.

(c) Use this Software on a single computer only, but may transfer it to
another computer as long as it is used on only one computer at a time. “In
Use” constitutes being loaded onto either temporary (i.e., RAM) or
permanent memory (e.g., hard disk, CD-ROM or other storage device) of a
computer.

2. Restrictions.

You may NOT distribute copies of the Software to others or electronically transfer
the Software from one computer to another over a network. You may not de-
compile, reverse engineer, disassemble or otherwise reduce the Software to a
human perceivable form. You may not modify, adapt, transfer, rent, lease, loan,
resell for profit, distribute, network or create derivative works based upon the
software or any part thereof.

3. Termination.

This License is effective until terminated. This License will terminate immediately if
you fail to comply with any of its provisions. Upon termination, you must return the
Software, and all copies thereof, to Scanvec Amiable, Inc., and you may terminate
this License at any time by doing so.
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4. Export Law Assurances.

You agree that neither the Software nor any direct product thereof will be
transferred or exported, directly or indirectly, into any country prohibited by the
United States Export Administration Act or any international export laws and the
restrictions and regulations thereunder, nor will it be used for any purposes
prohibited by the Act or laws.

5. Warranty Disclaimer, Limitation of Remedies and Damages.

In no event will Scanvec Amiable, Inc., be liable for any damages, including
infringement, lost data, lost profits, cost of cover or other special, incidental,
consequential or indirect damages arising from the use of the program however
caused and on any theory of liability. This limitation will apply even if Scanvec
Amiable, Inc., or an authorized dealer or distributor has been advised of the
possibility of such damage. SCANVEC AMIABLE, Inc. MAKES NO WARRANTY,
EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, AND
DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE. Scanvec
Amiable, Inc., does not warrant any drivers for plotting, scanning or either devices.
These drivers are provided for our customers as a service only, and were
developed using information provided to us at the time by the equipment
manufacturers.

Scanvec Amiable, Inc., is not responsible for any typographical errors in the
software or in the documentation.

6. General.

If you are a U.S. Government end-user, this License of the Software conveys only
"RESTRICTED RIGHTS," and its use, disclosure, and duplication are subject to
Federal Acquisition Regulations, 52.227-7013(c)(1)(i)). This License will be
construed under the laws of the State of Pennsylvania, except for that body of law
dealing with conflicts of law, if obtained in the U.S., or the laws of jurisdiction where
obtained, if obtained outside the U.S. If any provision of this License is held by a
court of competent jurisdiction to be contrary to law, that provision of this License
will remain in full force and effect.

© Copyright 2008 by Scanvec Amiable, Inc. All rights reserved. No part of this
publication may be reproduced, stored in a retrieval system or transmitted, in any
form or by any means, electronic, mechanical, photocopy, recording or otherwise,
without the prior written permission of the publisher. Printed in the United States of
America. The information in this manual is subject to change without notice and
does not represent a commitment on the part of Scanvec Amiable, Inc.

Acrobat® Reader Copyright© 1987-2008 Adobe Systems Incorporated. All rights
reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated
which may be registered in certain jurisdictions. PostScript® software Copyright©
1984-1998 Adobe Systems Incorporated. All rights reserved.

Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FIexiEXPERT, FlexiSIGN,
FlexiLETTER, FlexiDESIGNER, FlexiCUT, FlexiENGRAVE, PhotoPRINT Server,
PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRoute-
Machine Shop, and/or other Scanvec Amiable products referenced herein are



either trademarks or registered trademarks of Scanvec Amiable, Inc. lllustrator is a
registered trademark of Adobe Systems Incorporated. FreeHand is a registered
trademark of Macromedia Corporation. CorelIDRAW! is a trademark of Corel
Systems Corporation. AppleTalk, ImageWriter, LaserWriter, and Macintosh are
registered trademarks of Apple Computer, Inc. Windows is a registered trademark
of Microsoft Corporation. The names of actual companies and products mentioned
herein may be the trademarks and/or registered trademarks of their respective
owners. Adobe® is a trademark of Adobe Systems Incorporated or its subsidiaries
and may be registered in certain jurisdictions. PostScript® is a trademark of Adobe
Systems Incorporated or its subsidiaries and may be registered in certain
jurisdictions.

SA International
International Plaza Two, Suite 625
Philadelphia, PA 19113-1518
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Introduction

Cutting Master 2 for CraftROBO is a program that allows you to

output directly from your design application to a cutter. Installing Visual Basic for Applications (VBA) for

CorelDRAW 10
) ) ) VBA automatically installs for CorelDRAW 11, 12, X3 and X4.
e The Cut/Plot plug-in that allows you to set job properties for

the cut job from within your design application and sends the When you install CoreIDRAW 10 through the typical installation,
job to Cutting Master 2 for CraftROBO. VBA does not automatically install. You must install VBA in

order to run the Cut/Plot feature of your software.

It consists of two parts:

e The Cutting Master 2 for CraftROBO program that receives

the job from the Cut/Plot plug-in and outputs it to the cutter. If you need to install CoreDRAW and VBA:
1. When installing CoreIDRAW, select Custom Setup.
Using the Software 2. From the list of components, select Visual Basic for

Applications 6.0 & IE 5.

3. Continue with regular installation.

To send a job to a cutter using Cutting Master 2 for CraftROBO:

Create the job in the design application.
If you need to install VBA only:

4. Insert the CoreIDRAW CD.

5. From the Corel Setup Wizard, select Add New
Components.

If desired, add registration marks to your design.
Open the Cut/Plot dialog.

Send the job to Cutting Master 2 for CraftROBO. 6. From the list of components, select Visual Basic for

Use Cutting Master 2 for CraftROBO to output the job to the Applications 6.0 & IE 5.
cutter.

1
2
3
4. Adjust the job properties in the Cut/Plot dialog.
5
6

Supported Applications

On Windows, Cutting Master 2 for CraftROBO supports the
following design applications:

e Corel CorelIDRAW 10, 11, 12, X3, X4
e Adobe lllustrator 8, 9, 10, CS, CS2, CS3

On Macintosh OS X, Cutting Master 2 for CraftROBO supports
the following design applications:

e Adobe lllustrator 10, CS, CS2, CS3

© 2008 Graphtec Corp. 1



Installation and Setup

Before you begin installing the software, read the hardware
requirements below. For optimal performance we suggest that
your system meet the recommended requirements. As with all
computer software, systems with faster processors, more RAM,
and greater amounts of storage space allow you to work with
larger files and keep your processing time to a minimum.

Recommended System Requirements

Windows Macintosh
Processor Pentium Il 600 MHz G4 or greater
RAM 256 MB
Install Space 100 MB

Operating System | Windows 2000, XP, Vista [ OSX 10.2 or greater

Video 800x600 resolution monitor with 16 bit color
4x CD-ROM or DVD Drive

Other : -
Available Port for Output Device

Before You Install the Software

Before you install the software, you should do the following:
o Install all of your design applications.

e Install any additional drivers that are necessary for your
cutters, such as USB drivers.

e Set your cutter to operate in GPGL mode. See your cutter
documentation for details.
Installing the Software (Windows)
To install Cutting Master 2 for CraftROBO:
1. Uninstall any previous version of the software.
2. Insert the Installation CD.

© 2008 Graphtec Corp.

10.
11.

12.
13.

Select a language and then click OK.

Select the product and language to be installed and then
click Next.

On the Welcome screen, click Next.

Read the Software License Agreement and click Yes to
accept.

Select the components of the software that you want to
install. You may also change the folder the software will be
installed into. Click Next.

Select the Start menu folder where the shortcut for the
software will appear. By default, a new folder will be created
for the product. Click Next.

Select whether additional shortcuts for the software will be
created:

a. Check Install to desktop to install a shortcut for the
software on the desktop.

b. Click Next.
Click Next to begin installing the software.

If you have Adobe lllustrator installed, you will be prompted
for the location of the Plug-ins folder for each version of
Illustrator you have installed.

a. If necessary, click Browse and select the folder location.
Click Yes to clear the preferences.

Select Finish.

Uninstalling the Software (Windows)

1.

Exit Cutting Master 2 for CraftROBO by selecting Exit from
File menu.

In the Windows Control Panel, double-click the Add or
Remove Programs icon.



3. Select Cutting Master 2 for CraftROBO from the list and
click the Change/Remove button.

In the Welcome screen, select Remove and click Next.
Click Yes to uninstall the software.

Installing the Software (Macintosh)

Follow these steps to install the software:
1. Insert the Installation CD.

2. Double click the Installer icon.

3. Select a language and then click OK.
4

Select the product and language to be installed and then
click OK.

Read the Software License Agreement and click Accept.
Click Next.
Select the Install Location and click Install.

o

Click Stop to halt installation.
8. Click Yes to clear the preferences.
9. Click OK.
10. Click Quit.

Uninstalling the Software (Macintosh)

1. Exit Cutting Master 2 for CraftROBO by selecting Quit from
the application menu.

2. Inthe Cutting Master folder, double-click Uninstall.
3. Click OK.

Creating an Output Device Setup

The first time that you run Cutting Master 2 for CraftROBO, you
will be prompted to create an output device setup. See
“Creating an Output Device Setup in Cutting Master 2 for
CraftROBO” page 12 for details.
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Using Preference Manager

Available preferences:

Factory Defaults Save...

Standard 5 etups

Load

Exit

Preference Manager is a utility that allows you to save all of the
settings in the software to a file, including all output device
setups and all application preferences.

You cannot load a set of preferences while either the design
software or Cutting Master 2 for CraftROBO is running. You can
save preferences at any time.

Saving a Set of Preferences

To save the current set of preferences to a file:

1. Run Preference Manager.

2. Click Save.
|
QK I Cancel |

3. Type the name for the set of preferences in the field and
click OK.

Loading a Set of Preferences

To reload a previously saved set of preferences:
1. Exit the software.

2. Run Preference Manager.

3. Select the set of preferences you want to load.



4. Click Load.

Restoring the Software to its Original State.

The default settings for the software are stored in the Factory
Defaults set of preferences. Restoring the software to its default
state may be particularly helpful when troubleshooting any
problems you may encounter with Cutting Master 2 for
CraftROBO.

Loading this set of preferences will remove the output device setup in Cutting
Master 2 for CraftROBO.

To clear the preferences stored in your system:
1. Exit the software.

2. Run Preference Manager.

3. Select Factory Defaults.

4. Click Load.

Exiting Preference Manager

To exit Preference Manager, click Exit.

© 2008 Graphtec Corp.



Creating the Job in the Design Application

The first step in outputting a job using Cutting Master 2 for
CraftROBO is to create the job in your design application.

Guidelines for Creating Your Design

When creating a job, remember the following guidelines:

Convert all bitmap graphics into vector objects. Cutting
Master 2 for CraftROBO can only output vector objects.

Objects cannot have patterned fills, bitmap fills, lens effects,
gradients, or other custom fill types. Any objects with these
fill types will be ignored by Cutting Master 2 for CraftROBO,
and will not appear in the Cut/Plot dialog.

Use colors or layers to separate objects that you want to
output at different times. You can then use the Layering tab
of the Cut/Plot dialog to choose which colors or layers will
be output.

There is no need to make duplicate copies of your design in
the design application. Cutting Master 2 for CraftROBO can
easily output duplicates of any design, and can even place
multiple copies on the same page.

Don’t worry about objects of the same color that overlap.
The Auto-Weld feature can automatically merge overlapping
objects together.

If you need to make multiple cutting passes, you can select
the number of passes in the Advanced tab of the Cut/Plot
dialog. There is no need to stack up multiple copies of an
object to force multiple cutting passes.
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Accessing the Cut/Plot Dialog

Once you have created your job, the next step is to open the
Cut/Plot dialog.

To access the Cutting Master 2 for CraftROBO Cut/Plot dialog:

S[=E
Craft ROBO cc300-20@Graph [ Status |
Propertizs... If p—
__ Propenies. | [fy] -| =
&le|w | =)
~ Media size 8 7 & 5 & 3 2 1 o[a
[User defined =l |
£ [3268n = 20 [rzeslse deoc] ; | }
rJob size o
o [n30en = % [oooon =
e
t [oooen = 6 [ooooo: =
™ Fitto media ¥ Proportional E
 Position E
(¢ [0000n = F oo = .
P =] »= F o
I/ Selestion ol —
= = & —
M
=
| i
] 4
Resat L B
[ Totalsze 1037nx 22430 Snd | Do [

If you are using Adobe lllustrator, from the File menu, select
Cutting Master 2 for CraftROBO then Cut/Plot.

If you are using CorelDRAW, select Cut/Plot from the Corel
Application Launcher. The Corel Application Launcher is a
list in the standard toolbar that lets you launch other
applications from within CoreIDRAW. It uses the following
icons, depending on your version of CorelDraw:

-3‘.:: CorelDRAW 10 ﬁ[;[‘ CorelDRAW 12, X3 & X4
7tz CorelDRAW 11




Entering Numerical Values Simple Arithmetic Operators

If you enter a simple arithmetic expression, the software will

Cutting Master 2 for CraftROBO supports a number of unique . .
calculate the result of the expression and enter that value in the

features that make it easier to enter numerical values.

field.
Using Built-In Mathematical Operations The available arithmetic operators, in order of precedence, are:
The software is able to perform a number of calculations /| Division
whenever a numerical value is being entered. « | Multiplication
Automatic Unit Conversion + | Addition
If you enter a value using a different unit of measurement than - | Subtraction

the default unit, the software will automatically convert the value , ,
to the default unit. For example, if you enter 1/8, the value 0.125 will be calculated.
Operator precedence determines the order in which the
arithmetic operations will be calculated when more than one
operation is specified. In the previous list, operators are listed
Supported units are: from top to bottom in order of operator precedence. For

instance, if you enter 6/2*3, the software will calculate 6/2 first

then multiply the result by 3, yielding a result of 9.

For instance, if your default unit is inches, you can enter a value
of 1 ft, and the software will convert the measurement to 12 in.

in," | inch
ft, ' foot

mm | millimeter Automatic Application of Entered Values and

: Arithmetic
cm centimeter
Once you enter a numerical value, ratio, or arithmetic
m__ [ meter expression in a numerical field, the software will automatically
pt point apply that value after a brief delay.

Calculation of Ratios

If you enter a ratio in the format A:B, the software will scale the
previous value in the field by the ratio entered.

For instance, if a value is set to 12, and you enter 2.3, the new
value will be 8.
Calculation of Percentages

If you enter a percentage in the format X%, the software will
scale the previous value in the field by the percentage entered.

For instance, if a value is set to 10, and you enter 90%, the new
value will be 9.

© 2008 Graphtec Corp. 6



Setting Job Properties

The following controls are available on all tabs of the Cut/Plot

dialog:

Properties

B

2]

Reset
Send

Done

Click to adjust the setup properties. See “Editing Output
Device Settings” page 14 for details.

Click to start Cutting Master 2 for CraftROBO.

Click to select the Select tool. (This tool is selected by
default most of the time)

Click to select the Zoom tool. Click and drag in the job
preview pane to select an area of the design to zoom in on.
For Windows, hold the CTRL key and click to zoom out. For
Macintosh, hold the Option key and click to zoom out.

Click to select Zoom to Width. The preview pane will
automatically zoom in or out so that the entire width of the
media is displayed.

Click to select Zoom to All Objects. The preview window
will zoom in or out so that all of the objects in the design are
displayed.

Click to return job properties to their default settings.

Send the job to Cutting Master 2 for CraftROBO with the
current settings.

Close the Cut/Plot dialog and return to the design
application.
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Setting General Tab Properties

The General tab allows you to specify the size of m
the job and the location of your output on the media.

edia, size of

¥ Cut/Plot

=1oj x|

Craft ROBO) cc300-20@Graph b T[stbs I
Properties {
__Propenes. | 1A =
gle|v |
[ Media size & = 85 4 3 2 1 0[]
IUserdeﬁned j - | ‘
N = e o= | }
i Job size o
+ [i0308n = % [0ooow =
of
t [oooon = 26 [tooooon
I Fitto media F Proportional e
- Position E
¢ [0.000n = = [oooon = A
L d = F o
| Selection oy p——
o :
- L —é
of
Reset L] =
[& Q|=|®] Tomisze 103inx2249n Send Done

The following settings are available:

Media The size of the media loaded into your output device. Select
Size from one of the preset sizes, or specify unique dimensions
below.

[=[I] The width and height of the media. When a set of
unigue dimensions is specified, it is automatically
added to the list of preset sizes.

Job Size Choosing one of these options allows you change the output

size and orientation of the page.

= The job's width and height.

'9};" Toz The job's width and height as a percentage
of the original.

Fit to Media Scales the job proportionally so that it is as

large as possible while still fitting within the
cuttable area of the output media.



Proportional  When this option is selected, the height and Setting Layering Tab Properties

width of the job are increased or decreased . . . .
together to keep the original proportions The layering tab allows you to assign different cutting

intact. parameters to different color or layers in your cutting job. You

Position These settings change the position of the job on the media. can cut one color slower than another color, for instance.

. . . “7 Cut/Plot 1o x|
o El The distance between the job and the right and Gt ROBO o300 20@Graph I b Status I
bottom margins of the cuttable area. You can __Popetes. | 1A =
also change these settings by dragging the job 8 ® |9 | )
across the page in the preview pane. L l,s T s e e e .‘o|.|
il Interactive: moves the cutter as you Change E.::‘o ;::::555355 B255 l.iZ:EM.ZI cc300-20 ol | \
the position of the job on the preview area. - [l RoGu e CraftROBO cc200-20 ?| |
|7 . R127G255 B0 Craft ROBO cc300-20
Show me: draws a bounding box of the job st carooamn | N Ny
=i without lowering the tool. [?r FoG1Z7E255 i ek =
=N Places the job at the specified distances from e e b —
* the lower and right edges of the cuttable area of T Enblediveroptions ———————————————— | =)
the output media. I Gl seffing for o of
. = ) Preset: [Bond Paper 13-28 Ibs = | ==
0 Places the job at the specified distances from oot [T e[ )
. the lower and left edges of the cuttable area of _ = — SN ——
the output media. e TS e ) B ;
Testaut: [/ =
3-1] Centers the job along the width of the cuttable Passes: [T b = 4
area. ™| Platter contraller Reset i >
¥4 Centers the job in the middle of the cuttable [% Q|| @] Toase 1032288 Send pere [

area. Only available for sheet material.

%| o= Rotates the image on the media in 90-degree The following settings are available:
e

increments. Click the button until you achieve

=5 - h ) By color/  Orders your output by color, or by layer. “Layer” refers to
. the desired orientation. By layer layers in the design application, not overlapping layers of
ﬂ ﬁ Flips the selected image on the vertical axis, so vinyl.
that your image will be mirrored when output. « If you choose By color, all objects with the same color will
Selection  Output only the selected objects, not the entire design. This be cut at the same time, unless Pause between _
Only option is enabled if you had objects selected when you colors/layers is checked. If you have overlapping objects
opened the dialog. of the same color, you will get overlapping contour cuts.

o If you chose By layer, the job will be cut one layer at a
time. All objects in each layer will be cut at once, unless
Pause between colors/layers is checked. If you have
overlapping objects in a layer, you will get overlapping
contour cuts.

© 2008 Graphtec Corp. 8



Pause
between
colors/
layers

Enable
driver
options

If checked, output will be paused between colors or layers. Line
This allows you to load different colored vinyl into your Type
cutter.

If cleared, the job will be sent as a single layer. The Single
setting for all option will automatically be checked, and
identical driver options will be used for the entire job. If
weedlines are enabled, there will only be a single set of
weedlines for the entire job.

Check to set the following options in the software. If this
option is not checked, the settings on the output device will
be used instead.

Settings can be set individually for each color or layer by

selecting the color or layer in the list then setting the options )

below (but see Single setting for all). P!tCh
. Size

Single

setting

for all

If this option is checked, identical driver options

will be used for all colors or layers. @l

If Pause between colors/layers is not
checked, Single setting for all is automatically
checked, and may not be cleared. This is
because the job is automatically sent as a
single layer when Pause between
colors/layers is not checked.

Preset Plotter

Driver option presets allow you to save all of the
driver options for a common type of job and
reapply them in a single step. See “Working

with Driver Option Presets” below, for details.

Test Cut

Passes

Select the line type.

The following line types are provided as
standard:

You can also edit three custom line types. See
“Editing Custom Line Types” page 10 for
details.

The length it takes for the line pattern to repeat
when a line type other than solid is selected.

Allows you to output test cutting jobs to
appropriate output devices, to make sure
everything is functioning properly.

Defines the number of times that the blade will
cut the same path. Set this option if you are
using thick or hard media that can’'t be cut in a
single pass.

If checked, Cutting Master 2 for CraftROBO will send the

Controller current job to the Graphtec Plotter Controller application for
output when the Send button is clicked. This option is only
enabled if the setup is for a device that is supported by the

Plotter Controller application. The device setup must use a

Speed Speed at which the cutting head or pen moves

across the media.
Set to 0 to use the setting on the cutter.

Force The amount of downwards force applied to the
cutting head or pen.

USB connection. If Plotter Controller is not installed, this
option will be disabled. See the Plotter Controller
documentation for details on outputting jobs from that
application.

When this option is checked, the following fields in the

cut/plot dialog will be disabled:

Set to O to use the setting on the cutter.

e Job width
¢ Job height

e Percent width

¢ Percent height

¢ Fit to media

¢ Proportional

© 2008 Graphtec Corp.



e Use registration marks

In addition, the Rotation control will be limited to the 0 and
90 degrees counterclockwise settings. ﬂ ﬂ

Working with Driver Option Presets
Driver option presets allow you to save all of the driver options
for a common type of job and reapply them in a single step.
Creating Presets
To save the current driver options as a nhew preset:

1. From the Preset list, select Save as.

()8 I Cancel |

2. Enter a name for the new preset.
3. Click OK.

Updating Presets

To update the currently selected preset with the currently
selected driver options, from the Preset list, select Save.
Applying a Preset

To apply the driver options saved in a preset to the current job,
select the preset from the Preset list.

Renaming a Preset

To rename a preset:

1. Select the preset you want to rename from the Preset list.

2. Select the Rename command from the Preset list.

3. Type in the new name and press OK.
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Deleting a Preset
To delete a preset:
1. Select the preset you want to delete from the Preset list.
2. Select the Delete command from the Preset list.
dl Do wou really want ko delete the preset?

es Mo |

3. Click Yes.

Editing Custom Line Types
To edit the custom line types:
1. Select Edit from the Line Type list.

a b ®
Custom 1: ID.D24in ::|I ID.DDSin ﬁ a b a b a b
Custom2: |0000in = |0.000n S |0000n = T LThTLE E bThETL I
Custom3: [0.000n  =40/0000in  =4[0000n = =BT 3 bTH 3 b
Ok I Cancel |

2. Specify the three custom line types by listing the lengths of
the line segments and spaces that make up the line:
a The length of the first segment in the line.
The length of the space between line segments.

¢ The length of the second and third line segments, if any. Custom
1 is made up of one repeating line segment, while Custom 2 has
two segments that repeat in a pattern, and Custom 3 has three.

3. Click OK.
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Setting Advanced Tab Properties Sending Jobs to Cutting Master 2 for CraftROBO

The Advanced tab allows you to set several options specific to To send the current job to Cutting Master 2 for CraftROBO for
cutting jobs. output, click the Send button in the Cut/Plot dialog. To exit the
7 cut/Plot i ol x| Cut/Plot dialog, click Done.
Craft ROBO) cc300-20@Graph b T[stbs I
roeets. | ) E.Ii Once sent to Cutting Master 2 for CraftROBO, the job will
ale ¥ | immediately be output, unless the Hold in List option on the
et ot e P —e—e—t—e e gl General tab of the Cut/Plot dialog is checked. If Hold in List is
Tl \ checked, the job must be output manually. See “Outputting Jobs
v s o & | from Cutting Master 2 for CraftROBQO” page 15 for details.
Once output, the job will either be deleted, or held in the queue,
. depending on the After Output setting in the Advanced tab of
1 the Cut/Plot dialog. See “Setting Advanced Tab Properties”
) page 11 for details.
[% Q|=|®[ Tomisze  103inxz249n Send Done
The following settings are available:
Auto-weld Removes overlapping areas of objects that have the
same color.
Convert Selects whether the strokes will be cut separately as an
strokes to object.
outlines
Units Specifies the units that will be used for measurements.
Use Can be used to align a contour cut with the printed
Registration output.
Marks
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Outputting Jobs from Cutting Master 2 for CraftROBO

Basic Elements of Cutting Master 2 for CraftROBO

The following are the basic elements of Cutting Master 2 for
CraftROBO:

I [ [Of %]

File Edit Setup View Help

Toolbar

Job Mame | Skatus Copies | File tvpe | Color
Snowflakes, job Holding 1 Cut job Multiple

CovokeCarehos, .,

Job
Area

ol |

|RAM: 1007 ME 631 ME free ¥IM:2179 ME free 1143611 MB free D:147157 ME free

A

Column Headings
Note the column headings in the job area:
Job Name  The file name of the job.
Status The current status of the job.
Copies The number of copies to be output.

File Type The type of job.

Color The color specified for the material. If multiple colors are
specified, this field will read Multiple.

Toolbar

A toolbar is located at the top of the main window. It contains
tools for the most commonly used functions.

To show or hide a toolbar, select Toolbar from the View menu.
The toolbar functions are:

Q Add Job  Adds a job to the selected output device.

Save As Saves the selected job to a file.
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-Jhl Send Job  Sends the selected job to the output device.

@ Abort Stops selected file from being output.

ﬁ Delete Deletes the selected job or jobs.

Setting Application Preferences

To set application preferences, from the Edit menu select

Preferences.

Urits:

Precision: I 0.000 - l

Reset | ()8 I Cancel |

The following settings are available:

Units The units of measurement displayed.

Precision The degree of precision to use with measurements.
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Creating an Output Device Setup in Cutting Master
2 for CraftROBO

The output device setup provides the link between the software
and your output device. It contains the following information:

e The type of output device being used.

e The method used to communicate with the device.

Creating Your First Output Device Setup

When you start the software for the first time, you are prompted
to create your first output device setup:

x
Click the manufacturer and model of your setup.
Manufacturer: Model name:
Graphtec GPGL CraftROBO cc100-20
CrafROBC cc200-20
CraftROBO cc300-20
CratROBC cc300L-20
CraftROBO cc330-20
CraftROBC ec330L-20
< Back Next > Cancel |

1. Select the Manufacturer and Model Name of the output
device from the list.

2. Click Next.

© 2008 Graphtec Corp.

Change Setup =

Setup name: | CraftROB0 oc100-20_1]

< Back I Mest > I Cancel

Edit the Setup name of the device.
Click Next.
x|

Port: IGraphtec UsE j

< Back Cancel |

Select the Port the output device uses for communication. If
necessary, edit the communications settings for the chosen
port.

Click Finish.
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Changing the Output Device Setup

The software allows only one output device setup to be in use at
any given time. Creating a new setup will eliminate the existing
one.

To change the output device setup, from the Setup menu,
select Change Setup.

The steps to create the new setup are the same as the ones for
the original setup.
Editing Output Device Settings

To edit the properties associated with the output device setup,
from the Setup menu, select Setup Properties.

Job Workflow Tab 5]

& |2 |
The Job Workflow tab
disp|ays information about Setup name: | [ASEIINGE
the output device.

Reset |
Apply | QK I Cancel |

Setup name Name of the setup.

© 2008 Graphtec Corp.

Communication Tab =

The Settings section of this
tab changes depending on
the port used to connect to
the output device.

Ports are listed in order of
popularity for each device.
Only the ports that are
usable by the output device
are listed.

The standard port for the
device is selected by
default. Some of the port
settings may still need to be
entered or edited, however.

| ()8 I Cancel |

Port  Select the port to which the cutter is connected. The port list is
limited to the ports that are actually present on your computer and

usable with your output device.

USB USB drivers are provided with output devices that
support them. Please make sure the proper drivers are

installed when using these ports.

14



Outputting a Test Cut Job

The software allows you to output test cutting jobs to
appropriate output devices, to make sure everything is
functioning properly.

To output a test cut job, from the Setup menu, select Test Cut.

Outputting Jobs from Cutting Master 2 for
CraftROBO

Saving a Job to a File
To save a job to a .PLT file, do one of the following:
e Select the job and from the File menu, select Save As.

e Select the job, then click on the Save As button in the
toolbar.

¢ Right-click the job and select Save As from the context
menu.
Loading a Saved Job from a File
To load a previously-saved job from a file:

1. From the File menu, select Add Job.

Lok in: [ (3 Temp =l = ®&ckE-
[& snowfiakez plt Add

IV Preview
I™ Copy to job folder

Ll L«

Files of type: [0l Readable

2. Select the file to be added.
© 2008 Graphtec Corp.

3. If you want to copy the file to the local job folder, check
Copy to job folder.

If the job is on removable media or a network drive, copying it to a local folder
will allow you to process the job after removing the media or disconnecting
from the network.

4. Click Add.

Sending Jobs to the Cutter
To send a job to the cutter, do one of the following:
e Select the job and from the File menu, select Send.
o Select the job, then click on the Send button in the toolbar.

¢ Right-click the job and select Send from the context menu.

Aborting the Processing of a Job

To abort the processing of a job while it is being cut, do one of
the following:

e Select the job and from the File menu, select Abort.
e Select the job, then click on the Abort button in the toolbar.
¢ Right-click the job, then select Abort from the context menu.

If a job is aborted while being output, its status freezes at 0%.

Deleting Jobs
To delete a job, do one of the following:

e Select the job and press the Delete or Backspace key on
your keyboard.

e Select the job and from the Edit menu, select Delete.
e Select the job, then click on the Delete button in the toolbar.

e Right-click the job, then select Delete from the context
menu.
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Cutting Master 2 for CraftROBO allows you to use a cutter to cut
a contour on printed output generated on a separate printer.
This produces output similar to that of a hybrid printer/cutter
device.

In order to cut a contour on a printed job, you need to do the
following:

1. Create the design for the job in your design application.

2. Add registration marks that will allow Cutting Master 2 for
CraftROBO to align the cut contour with the printed job.

Output the printed parts of your design.
Load the printed media into your cutter.

Output the contour part of your design on your cutter.

Designing a Job for Virtual Hybrid Output

When designing a job for virtual hybrid output, the most
important thing is that you should be able to separate the
printed parts of the job from the cut parts of the job.

This can be done in two ways:

e By placing printed and cut elements on separate layers and
then hiding the layers you do not want to output.

e By manually selecting the elements you want to print or cut,
and then printing or cutting only the selected elements.

Of these two methods, we recommend using separate layers to
isolate printed and cut elements, as this works much better with
complex designs.

© 2008 Graphtec Corp.

Contour Cutting Using Cutting Master 2 for CraftROBO

Adding Registration Marks to the Print Job

The Cutting Master 2 for CraftROBO plug-in allows you to add
registration marks to your design. These registration marks can
then be used to align a contour cut with the printed output.

The registration marks are added in their own separate, locked
layer of the design.

Do not change the name assigned to the layer containing the registration marks.

The registration marks must be printed out in order to be used
for automatic alignment of a contour cut. The marks themselves
will not be contour cut.

There are two ways to add registration marks to a design:
e Adding registration marks automatically.

e Adding a rectangle to the design and replacing it with
registration marks.

If the design is changed or resized after the registration marks are added, you will
need to remove the registration marks and add them again in order to properly
indicate the new size of the job. Registration marks do not automatically update
when a job is edited or resized.
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Adding Registration Marks Automatically

If no object is selected, Cutting Master 2 for CraftROBO will
automatically add registration marks around your design.

To add registration marks to your design:
1. Open your job in the design application.
2. Access the Registration Marks dialog using one of the

following methods:

e In Adobe lllustrator, from the File menu, select Cutting
Master 2 for CraftROBO then Registration marks.

e In CorelDRAW, select Registration Marks from the
Corel Application Launcher.
Launcher is a list in the standard toolbar that lets you
launch other applications from within CorelDRAW. It
uses the following icons, depending on your version of

CorelDraw:

The Corel

{2 CorelDRAW 10 ‘{a‘ CorelDRAW 12, X3 & X4

itz CorelDRAW 11

LD] Graphtec Type 2 Automatic j
Units: I Inches j
t argin: m

Direction: I Horizontal j

™| Conwert rectangle

Total zize:17.62in = 17.E2in

Reset |

x|

Cancel |

Application

3. Select the desired registration mark from the topmost list.

[0 None

B

D Graphtec Type 2 Automatic
-

L
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4. Set the following options:

Units The unit of measurement.

Margin The distance between the registration marks and the
job.

Direction If checked, Segment Area type marks will be rotated
90 degrees

Convert If checked, the registration marks will be placed

Rectangle around the border of the selected rectangle. The
rectangle will then be deleted, leaving only the
registration marks.

Total size The dimensions of the area covered by both the job
and the registration marks together.

5. Click OK.

Replacing a Rectangle with Registration Marks

If a rectangle is created in the design application, and is
selected when the Registration Marks dialog is opened, Cutting
Master 2 for CraftROBO can use it as a bounding box for the
registration marks. The registration marks will be placed on the
border of the rectangle, and then the rectangle will be deleted,
leaving only the registration marks.

To replace a rectangle with registration marks:
1. Open your job in the design application.
2. Draw the rectangle that you want to use as a bounding box.

3. Access the Registration Marks dialog (see previous
instructions).

4. Make sure the Convert Rectangle option is checked.
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5. Set any other desired options (see previous instructions).
6. Click OK.

Removing Registration Marks
To remove the registration marks, do one of the following:

e Repeat the procedure used to add the marks, but select
None.

e Unlock and delete the layer that contains the registration
marks.

Outputting the Printed Parts of the Design

To output the printed parts of the design:
1. Hide the layer or layers which contain the contour cuts.

2. Make sure the layer or layers which contain the printed part
of the design are visible.

3. Use the standard printing function of the design application
to send the job to your printer.

Loading the Printed Media into Your Cutter

Once the printed parts of the job have been output, allow the ink
to dry (if necessary), then remove the media from the printer
and load it into your cutter.

Be sure to orient the printed media so that the registration
marks are not upside down, as this can cause problems.

© 2008 Graphtec Corp.

Load the media into the cutter then position the head over the
registration mark located at the top left corner when facing the
cutter.

Outputting the Contours to Your Cutter

To output the contour cut part of your design:

1.

Hide the layer or layers that contain the printed part of your
design.

Make sure the layer or layers that contain the contour cuts
are visible.

Use the Cut/Plot dialog to send the output to Cutting Master
2 for CraftROBO.

Send the cut job to the cutter from Cutting Master 2 for
CraftROBO, if necessary.
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